
ESTUDO DE UMA PONTE ROLANTE EM TRELIÇA ESPACIAL 

ENVOLVENDO MÚLTIPLAS CONDIÇOES DE CARREGAMENTO USANDO 

O ABAQUS 6.12 STUDENT EDITION 

 

1. INTRODUÇÃO 

 

O exemplo apresentado a seguir visa o estudo de uma ponte rolante 

industrial submetida a múltiplas condições de carregamento devidas às 

diversas posições em que a talha (guincho) pode estar posicionada.  

Trata-se de uma treliça espacial com 18,96 metros de vão e 9,10 metros 

de altura, conforme mostram as figuras a seguir. A talha tem capacidade 

máxima de içamento de 5000 Kgf (carga que a ponte suporta, além do peso 

próprio). As cargas atuantes sobre a estrutura, devidas ao peso próprio, são: 

P1 = 120 Kgf e P2 = 240 Kgf. A carga P1 é aplicada a cada um dos 4 nós que 

compõem as extremidades do banzo inferior da viga e a carga P2 é aplicada 

em cada um dos 26 nós que correspondem aos demais nós do banzo inferior 

da viga, que não estão sujeitos ao carregamento P1. A figura 1 e 2 mostram a 

geometria da ponte rolante e o carregamento devido à talha. As figuras 3 a 5 

mostram as vistas e dimensões da ponte rolante. 

 

Figura 1. Geometria da Ponte Rolante - Abaqus 



 

Figura 2. Geometria da Ponte Rolante 

 

1.2. PROPRIEDADES GEOMÉTRICAS 

 

Área das seções transversais das barras que compõem o banzo 

horizontal inferior e superior da viga e barras principais das colunas: A = 11.1 

cm² 

Área das seções transversais das diagonais, montantes e transversais 

da viga: A = 5.52 cm² 

Área das seções transversais das diagonais e horizontais das colunas: A 

= 3.95 cm² 



 

Figura 3. Vista Frontal e dimensões da ponte rolante (em cm) 

 

Figura 4. Vista superior da ponte rolante 



 

Figura 5. Vista lateral e dimensões da ponte rolante (em cm) 

 

1.3. PROPRIEDADES DOS MATERIAIS 

 

Módulo de elasticidade do material das barras: 2.1E6 Kgf/cm² (aço 

estrutural). 

 

2. RESOLUÇÃO 

 

O procedimento de resolução pode ser demonstrado no seguinte 

fluxograma (a ordem pode eventualmente ser quebrada em pontos específicos 

por conveniência): 



 

PRÉ-PROCESSAMENTO 

Início da Análise 

Criação da geometria base (Parts) Definir Tipo de Elementos 

Atribuição das propriedades dos 
materiais (Materials) 

Atribuição das propriedades das 
seções das barras (Sections) 

Associação das Seções, geometria 
base, materiais... (Section 
Assignments) (Assembly) 

Aplicarção das condições de 
contorno 

Cargas (Loads) 

Apoios (BCs) 

Criação da geometria da malha 
(Mesh) 

Elementos cálculaveis pelo 
método dos elementos finitos. 
Aproximação da estrutura real. 

Definição das Variáveis de Saída 
(Field Output Requests) 

PROCESSAMENTO 
Solução, Cálculos 

Computacionais (Jobs)  

PÓS-PROCESSAMENTO Análise dos resultados 

Variavéis de saída 

Análise gráfica 



 

2.1. INÍCIO DA ANÁLISE 

 

 Se você ainda não iniciou o programa Abaqus/CAE, digite cmd no 

Menu Iniciar para abrir o Prompt de Comando e nele digite 

abq6122se cae para executar o Abaqus. 

 Em Create Model Database na caixa Start Session que aparece, 

selecione With Standard/Explicit Model. 

 

2.2. PRÉ-PROCESSAMENTO 

 

 No menu Model à esquerda, clique com o botão direito em Model-1 e 

selecione Rename. Digite PonteRolante 

 No menu Model à esquerda, dê duplo clique em Parts, no campo Name 

digite Coluna1,  e selecione as opções: 3D Planar, Deformable, Point. 

Em approximate size digite 30. Clique em Continue... e tecle enter. 

 

 

 Na caixa de ferramentas, Clique em Create Datum Point: Enter 

Coordinates, para criar o ponto referencial de cordenadas dessa parte. 

Aceite a coordenada 0,0,0 teclando enter 



 

  

 Na caixa de ferramentas, Clique por alguns segundos em Create 

Datum Point: Enter Coordinates, e escolha a opção Create Datum 

Point: Offset From Point. Selecione o ponto criado (referência RP) e 

insira a coordenada: 0.55,7.50,0 teclando enter. Repita esse 

procedimento para as coordenadas: 1.75,7.5,0 e 1.75,7.5,1.6 e 

1.75,9.1,0 

 



 

 

 Agora, deve-se criar as barras. Na caixa de ferramentas, clique por 

alguns segundos em Create Wire: Planar e selecione Create Wire: Point 

To Point. Na janela Create Wire Feature, clique em “Add” (+). Junte os 

pontos, formando as barras, conforme a imagem (cada clique irá 

continuar a linha do ponto anterior). Clique em Done e em seguida OK. 

 

 

 Na caixa de ferramentas, clique por alguns segundos em Create Datum 

Point: Offset from point e selecione Create Datum Point: Enter 

Parameter. Selecione uma barra inferior e digite 0.2 e tecle enter. 



Repita esse procedimento para as outras duas barras inferiores, e 

também para os valores: 0.4, 0.6 e 0.8. 

 

 

 Na caixa de ferramentas, clique em Create Wire: Point To Point. Na janela 

Create Wire Feature, clique em “Add” (+). Junte os pontos, formando as 

barras restantes, conforme a imagem (cada clique irá continuar a linha 

do ponto anterior). Clique em Done e em seguida OK. 

 

 

 Abra Parts (1), e clique com o botão direito em Coluna1 e selecione 

“Copy”. Na janela Part Copy, nomeie-a Coluna2 e marque Mirror part 

about, selecionando Y-Z plane. Clique em OK 



 

 

 Na caixa de ferramentas, clique em Create Part. Nomeie-o 

BlocoExtremidade e clique em Continue... tecle enter. 

 

 
 Na caixa de ferramentas, Clique em Create Datum Point: Enter 

Coordinates, para criar o ponto referencial de coordenadas dessa parte. 

Aceite a coordenada 0,0,0 teclando enter. 

 Na caixa de ferramentas, Clique em Create Datum Point: Offset From 

Point. Selecione o ponto criado (referência RP) e insira a coordenada: 

1.6,0,0 teclando enter. Repita esse procedimento para as coordenadas: 

0,1.6,0 e 1.6,1.6,0. 



 Ainda em Create Datum Point: Offset From Point, selecione como 

referencia algum dos 4 pontos e insira as coordenadas  0,0,1.2 . Repita 

esse procedimento para os 3 demais pontos. 

 Na caixa de ferramentas, clique em Create Wire: Point To Point. Na 

janela Create Wire Feature, clique em “Add” (+). Junte os pontos, 

formando as barras, conforme a imagem (cada clique irá continuar a 

linha do ponto anterior). Clique em Done e em seguida OK. 

 

 

 Na caixa de ferramentas, clique em Create Part. Nomeie-o BlocoMeio , 

clique em Continue... e tecle enter. 

 Na caixa de ferramentas, Clique em Create Datum Point: Enter 

Coordinates, para criar o ponto referencial de coordenadas dessa parte. 

Aceite a coordenada 0,0,0 teclando enter. 

 Na caixa de ferramentas, Clique em Create Datum Point: Offset From 

Point. Selecione o ponto criado (referência RP) e insira a coordenada: 

1.58,0,0 teclando enter. Repita esse procedimento para as coordenadas: 

0,1.6,0 e 1.58,1.6,0 

 Ainda em Create Datum Point: Offset From Point, selecione como 

referencia algum dos 4 pontos e insira as coordenadas  0,0,1.2 . Repita 

esse procedimento para os demais. 

 Na caixa de ferramentas, clique em Create Wire: Point To Point. Na janela 

Create Wire Feature, clique em “Add” (+). Junte os pontos, formando as 



barras, conforme a imagem (cada clique irá continuar a linha do ponto 

anterior). Clique em Done e em seguida OK. 

 

 

 No menu Model à esquerda, dê duplo clique em Materials. Nomeie-o 

Aço Estrutural. Clique em Mechanical>Elasticity>Elastic. Em Data, no 

campo Young’s Modulus digite (2.1E10)*9.81 e clique OK. 

 

 

 No menu Model à esquerda, dê duplo clique em Sections. No campo 

Name digite SeçãoMaior, em Category selecione Beam, e em Type 

selecione Truss. Clique em Continue... 



 

 

 Na janela Edit Section, que estará aberta, veja que Aço Estrutural está 

selecionado e em Cross-sectional área, digite a área de 11.1E-4 

Clique em OK. 

 

 

 Repita o ultimo procedimento para criar as outras 2 seções (Name: 

SeçãoMédia e SeçãoMenor), com áreas de 5.52E-4 e 3.95E-4. 



 

 

 

 No menu model à esquerda, abra Parts>BlocoExtremidade e dê duplo 

clique em Section Assignments. Selecione as barras do banzo inferior 

e superior que formarão a viga, veja que está escrito set-2 e clique em  

Done. Na janela Edit Section Assignment, selecione a Seção Maior e 

clique OK. Repita esse procedimento, selecionando as barras 

diagonais e montantes, e associando à Seção Média (set-3). 



 

 

 
 No menu model à esquerda, abra Parts>BlocoMeio e dê duplo clique 

em Section Assignments. Selecione as barras do banzo inferior e 

superior que formarão a viga, veja que está escrito set-2 e clique em 

Done. Na janela Edit Section Assignment, selecione a SeçãoMaior e 

clique OK. 



 

 
 Repita esse procedimento, selecionando as barras diagonais e 

montantes, e associando à SeçãoMédia como mostra a imagem (set-3). 

 

 

 No menu model à esquerda, abra Parts>Coluna1 e dê duplo clique em 

Section Assignments. Selecione as barras principais como mostra a 

imagem, escreva em Create set: Set-2 clique em Done. Na janela Edit  

Section Assignment, selecione a Seção Maior e clique OK. 



 

 

 Repita esse procedimento, selecionando as barras diagonais e 

montantes, e associando-as à SeçãoMenor (Set-4), como segue na  

imagem. 

 

 

 Repita esse procedimento uma última vez, selecionando as barras 

diagonais e montantes de contato com o , e BlocoExtremidade

associando-as à , como segue na imagem. Seção Média (Set-3)



 

 

 Repita os procedimentos feitos de associação de seções para a 

, agora para a . coluna1 coluna2

 



 

 

 

 No menu Model à esquerda, abra Assembly e dê duplo clique em 

Instances. Certifique-se que o Instance Type consta em “Dependent 

(mesh on part)”, selecione (segurando a tecla ctrl) Coluna1, Coluna2, 

 e clique em OK. BlocoExtremidade



 

 
 Deve-se agora organizar as partes conforme a geometria da ponte 

rolante. Na caixa de ferramentas, selecione . Rotate Instance

Selecione o  e clique em BlocoExtremidade Done Selecione o eixo .  

de rotação, clicando em dois nós de uma das arestas verticais (primeiro 

o de ponto inferior, depois o superior). Agora, insira o ângulo de 

rotação: 90 e tecle enter. Clique em . OK

 

 
 Na caixa de ferramentas, selecione . Selecione o Translate Instance

BlocoExtremidade e clique em . Com esta ferramenta, é possível Done

transladar a parte selecionada, em função de um ponto referencial 



escolhido: após a escolha desse ponto, selecione o ponto onde se 

deseja posicionar a referencia (toda a parte irá se deslocar conforme o 

movimento desse ponto referencial) Posicione-o conforme a imagem. 

Clique em  OK

 

 
 Repita o procedimento, selecionando a coluna afastada, e 

posicionando-a conforme a imagem. 

 

 
 Na caixa de ferramentas, clique em Instance Part e insira o  

, e clique em . BlocoMeio OK



 

 
 Utilizando as ferramentas de rotação e translação, posicione o 

 conforme a imagem. BlocoMeio

 

 
 Na caixa de ferramentas, clique em . Selecione o linear pattern

 e clique em . Altere  em BlocoMeio Done Number Direction  para 1 , 1

e em Direction 2 para 6 e clique em  . Selecione uma linha na Direction

direção da viga. Altere  em  para 1.58 e clique em Offset Direction 2

 para endireitar a criação das cópias e verifique se a geometria Flip

corresponde com a imagem. 



 

 
  Na caixa de ferramentas, clique em . Selecione toda a Radial Pattern

estrutura e clique em . Altere  para 2,  para Done Number Total angle

180 e clicando em  selecione uma aresta vertical do meio Select axis...

da viga. Clique em . OK

 

 
 Utilize a ferramenta de translação, selecionando a cópia fora de 

posição, para ajustar conforme a geometria da ponte. 



 

 
 Na caixa de ferramentas, clique em . Na janela Merge/Cut Instance

, nomeie como Ponte Rolante Completa. Merge/Cut instance

Certifique-se que estão marcados os campos: ; Merge>Geometry

Suppress; Remove . Clique em  ...  Selecione toda a ponte. Continue

Clique em . Done

 



 

 

 No menu model à esquerda, dê duplo clique em Steps. No campo 

Name, digite Posição 1 e em Procedure Type, certifique-se que 

General>Static General está selecionado. Clique em Continue.... 

Então clique OK na nova janela que se abre. 

 

 

 Repita esse procedimento para criar as posições 2, 3, 4, 5 e 6. 



 

 

 No menu model à esquerda, dê duplo clique em BCs. Na janela Create 

Boundary Condition, altere o campo Name para Apoio Fixo, Step para 

Initial e Types for Selected Step para Displacement/Rotation. Clique 

em Continue.... Selecione qualquer um dos quatro pontos da base da 

ponte rolante e clique em Done. Marque na nova janela U1 , U2 e U3. 

Clique em OK. 

 



 

 

 Repita esse procedimento para criar os outros apoios (Apoio Móvel 1, 2 

e 3), selecionando os demais pontos da base da ponte, marcando na 

janela Edit Boundary Condition apenas  e .  U2 U3

 

 

 No menu model à esquerda, dê duplo clique em Loads. Na janela 

Create Load, no campo Name digite P1, troque o Step para Posição 1 

e clique em Continue.... 



 

 

 Selecione os 4 pontos extremos inferiores da viga e clique em  Na Done

janela Edit Load, no campo CF2 digite -120*9.81 e clique em OK. 

 

 

 Repita o procedimento para criar a carga P2, aplicada em todos os 

demais nós do banzo inferior da viga, aplicando em CF2 -240*9.81 



 

 

 Dê duplo clique em Loads. Na janela Create Load, no campo Name 

digite talha1, troque o Step para Posiçao1 e clique em Continue.... 

Selecione os 2 pontos extremos inferiores entre o primeiro e o segundo 

BlocoMeio e clique em . Na janela Edit Load, no campo CF2 Done

digite -2500*9.81 e clique em OK. 

 

 Repita o procedimento anterior para criar as cargas talha 2, talha 3, 

talha 4, talha 5 e talha 6 associadas aos Steps criados (posição 2, 

posição 3...). Selecione os nós por pares para as próximas posições, 

buscando simular a carga que se desloca sobre a ponte rolante. Faça 



assim como na imagem a seguir, onde foram selecionados os nós de 

aplicação para a posição 2. 

 

 

 Na caixa de ferramentas, clique em . Na janela aberta, Load Manager

selecione  após  para talha 1 e clique em Propagated Created

. Repita para as demais talhas como mostra a imagem. Deactivate

Clique em . Dismiss

 

 

 No menu model à esquerda, abra Parts>Ponte Rolante Completa e dê 

dois cliques em Mesh. Na barra de contexto, em Object, selecione 

Part. Na barra do menu principal, clique em Mesh>Element Type e 



selecione toda a região da treliça. Clicando em Done, abrirá a janela 

Element Type. Em Family, selecione Truss e clique OK. 

 

 

 Na barra do menu principal, clique em Seed>Edges e selecione toda a 

região da treliça novamente e clique em Done. Na janela Local Seeds, 

altere Method para By number e em Sizing Controls, altere Number 

of elements para 1. Clique em OK. 

 

 

 Na barra do menu principal, clique em Mesh>Part. Aparecerá a 

pergunta “OK to mesh the part?”, clique Yes. Note que a treliça fica na 

cor azul. 



 

 

2.3. PROCESSAMENTO 

 

 . No menu model à esquerda, duplo clique em Jobs. Na janela Create 

Job, apenas clique em Continue.... Na janela Edit Job, clique em OK. 

 

 

 Abra Jobs e clique com o botão direito em Job-1. Clique em Submit. 

Se aparecer uma janela dizendo “Job files already exist for Job-1. OK to 

overwrite?”, clique OK. Aguarde o processamento dos dados. Estará 

concluído quando aparecer “(Completed)” ao lado de Job-1 no menu 

model à esquerda. 



 

 

2.4. PÓS-PROCESSAMENTO 

 

 No menu model à esquerda, clique com o botão direito em Job-

1(Completed)>Results. A tela de análise de dados se abrirá. Na caixa 

de ferramentas, clique em Plot Contours on Deformed Shape. 

 

 

 Na barra de ferramentas no canto superior à direita, selecione S11 

onde, por padrão, estava selecionado Mises. Na caixa de ferramentas, 

clique em Common Options. Na janela Common Plot Options, 



selecione a aba Labels e marque Show element labels e show node 

labels. Clique OK. 

 

 

 Na barra de menu principal, clique em Viewport>Viewport Annotation 

Options.... Na janela aberta, selecione a aba Legend. Clique em Set 

Font. Na nova janela, altere Size para 14. Clique OK nas duas janelas 

abertas. 

 

 

 Na barra de menu principal, clique em Results>Step/Frame. Na janela 

aberta você pode ativar qualquer uma das 6 diferentes posições de 



carga criadas na estrutura. Selecione a posição 3 por exemplo e clique 

em Apply. Clique em OK. 

 

 

 Na barra de menu principal, clique em Report>Field Output. Na janela 

Report Field Output, clique em S: Stress components>S11 e clique 

em Step/Frame. Na janela Step/Frame, Selecione a posição 1 e 

clique em OK nas duas janelas. A mensagem aparecerá: “The field 

output report was appended to file “abaqus.rpt”.”. Repita para plotar os 

esforços na posição 6. O arquivo abaqus.rpt pode ser encontrado em 

C:\Users\”Nome do Usuário”\abaqus.rpt. 

 

 



 O arquivo listará os esforços das barras. 

Para a posição 1: 

 

Para a posição 6: 

 

 

 Na barra do menu principal, clique em Report Field Output. Na janela 

Report Field Output, clique em Step/Frame... selecione a posição 1 

e clique em OK, desmarque Stress Components e no campo 

Position selecione Unique Nodal. Então marque U:Spatial 

Displacement e clique OK. Repita para a posição 6. 

 

 



 O arquivo listará o deslocamento dos nós. 

Para a posição 1: 

 

 

Para a posição 6: 

 

 

 Na barra do menu principal, clique em File>Save As.... Dê um nome ao 

arquivo e clique em OK (É possível também salvar o arquivo com os 

resultados já calculados da situação 1- job-1.odb). 


